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Instructor Notes

Introduction
The Adobe® Premiere® Elements 9 Classroom in a Book® course presents students 
with tips, techniques, and solutions for using Adobe Premiere Elements. These 
Instructor Notes are intended to complement the information in the Adobe 
Premiere Elements 9 Classroom in a Book. 

The information is organized to follow the sequence of instruction in each lesson. 
However, the notes are not intended to expand on each and every exercise but 
rather to point out potential teaching opportunities not specifically covered in the 
lesson or areas where students might easily be confused. 

Course strategy
The book includes a Getting Started chapter and 13 lessons, which will take various 
lengths of time to complete. You can teach approximately one chapter of this book 
per session but—depending upon the number and duration of sessions in your 
class—you may wish to combine related exercises from some of the shorter lessons, 
or split up the more involved lessons. To this end, you should personally assess 
the complexity of the exercises in each lesson. Some non-essential exercises—and 
exercises that require Internet access when online connections are not available in 
the classroom—may best be assigned as follow-up homework. 

The following lesson summaries will help you structure your course:

•	 Getting Started explains how to install the application software and how to 
copy the lesson files from the application CD into the lessons folders. In the 
classroom setting, this instruction is best combined with Lesson 1, so your 
students will have access to a project with videos when they begin to explore the 
application interface. 

Please note that several of the projects used in these lessons include content, 
such as templates, that is available only in a full installation of Adobe Premiere 
Elements. Accordingly, you should advise your students to perform a complete 
application installation. Also note that the lessons and associated files used in 
this book will occupy over 4.4 GB of hard disk space. 

Although substantial care went into ensuring that all project files will 
automatically locate component files without user intervention, it’s impossible 
to predict all installation scenarios, particularly since the product is now cross-
platform, Mac and Windows. We hope that neither you nor your students will 
encounter problems; but if you do, you should be able to locate any unfound 
files and relink them within Adobe Premiere Elements. 
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•	 Lesson 1 describes how students will use Adobe Premiere Elements to produce 
movies while introducing them to the key panels, workspaces, and views found 
in Adobe Premiere Elements. Students will also learn the benefits of subscribing 
to Adobe Photoshop.com. 

•	 Lesson 2 teaches how to create a project, set relevant user preferences, and 
configure the interface. If some students are tempted to skip this chapter, you 
might advise them that they will not be able to change their project settings 
after they’ve chosen those settings and started editing. While Adobe Premiere 
Elements is a flexible and customizable program, your students may have to 
redo their work if they start a project with wrong settings. 

Depending on your class schedule, you should consider teaching at least 
Lessons 1 and 2 in concert because they are both introductory in nature and 
relatively brief. 

•	 Lesson 3 explains how to capture and import video from camcorders and other 
video devices in Adobe Premiere Elements. Students learn how to connect a 
camcorder to their computers; and use Video Importer to import video from an 
AVCHD camcorder, digital still camera, DVD, or DVD-based camcorder. They’ll 
also discover how to import audio, video, or still images already located on their 
hard drives. 

Although no project file is provided with this chapter, the final exercise does 
guide the student in importing book content from a folder on her hard drive. 
The capture process is very device specific, and you should consider how best to 
illustrate this in a class setting when students are using a multitude of different 
video devices, or have no classroom access to any video device. 

•	 Lesson 4 introduces students to the organizational workspaces in Adobe 
Premiere Elements; which now includes a full version of the Elements 
Organizer, and Media and Project view in the Organize workspace in Premiere 
Elements. Students will use each workspace, and also dive into Adobe Premiere 
Elements’ Auto-Analyze feature that adds Smart Tags to the content, which 
feeds into Adobe Premiere Elements SmartFix and Smart Trim functions and 
InstantMovie functionality. Students customize and create an InstantMovie as 
part of this lesson. 

•	 Lesson 5 details Adobe Premiere Elements’ Timeline and Sceneline, and 
explores various “nuts and bolts” editing tasks, such as inserting, deleting, 
splitting, and rearranging clips in the Sceneline and Timeline. Students also 
learn how to work with Smart Trim and how to create a slide show in Adobe 
Premiere Elements. 

•	 Lesson 6 is the Effects lesson. Students learn the difference between curative 
and artistic effects, and when and how to apply them. You’ll also introduce 
them to Adobe Premiere Elements’ SmartFix function, and the program’s 
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ability to apply one effect to many clips, and remove effects from many clips 
simultaneously. Specific tasks include creating a pan and zoom effect with a 
still image, controlling effects with keyframes, creating a picture-in-picture 
effect, compositing one video with another using Adobe Premiere Elements’ 
Videomerge function, and working with Motion Tracking and Effects Masking. 

•	 Lesson 7 demonstrates how to add nuance and dimension to movies by using 
transitions between clips. Students apply a transition to single and multiple 
clips in the Transitions view, preview transitions, customize transition settings, 
copy and paste transitions, create fade-ins and fade-outs, and render transitions 
for high quality preview. 

•	 Lesson 8 examines Adobe Premiere Elements’ title-related tools. Students 
create original titles and rolling credits for a production, and use some of the 
title templates that are installed with the application. 

•	 Lesson 9 examines the multiple audio-related features in Adobe Premiere 
Elements, including a real time narration tool; the ability to create, add, 
and modify background music tracks; and the multi-track mixer that can 
control volume levels within clips. To explore these features, students create 
a background music track, adjust the volume of an audio clip, add a narration 
clip, and mix the audio with Smart Mix and Adobe Premiere Element’s Audio 
Mixer for maximum impact. 

•	 Lesson 10 describes how students can apply a Movie theme to clips in the 
My Project panel to quickly produce an engaging, stylized movie. Themes and 
InstantMovies are essentially the same feature, with InstantMovies applied from 
the Organizer (with Smart Tagging), and Themes applied from the My Project 
panel, both using the same interface and customization options. For this reason, 
and because this lesson is extremely short, you might consider combining it 
with Lesson 4. 

•	 Lesson 11 is aimed at students who want to place their projects on a DVD or Blu-
ray disc, or output in an entirely new format called WebDVD. Students add menu 
markers to their videos, create, customize, and preview menus; and then burn a 
DVD or Blu-ray disc. Since Adobe Premiere Elements can record a disc image to 
a hard drive (in addition to recording the content to an actual disc), your students 
don’t need a DVD or Blu-ray recorder to follow along with this lesson. 

•	 Lesson 12 explains how students can share their videos with friends, families, 
and associates, including uploading their videos to YouTube, exporting a 
video file for subsequent viewing from a hard disk or mobile video device, and 
recording video to DV/HDV tape media. 

•	 Lesson 13 shows how to use Adobe Photoshop Elements and Adobe Premiere 
Elements in concert to seamlessly combine digital photography and video 
editing. Exercises demonstrate how to use the Edit Videos command in 
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Elements Organizer to create a slide show in Adobe Premiere Elements, and 
how to access Albums created in Photoshop Elements in Adobe Premiere 
Elements. Students also create a Photoshop file optimized for video and edit a 
Photoshop image within Adobe Premiere Elements. To complete these lessons, 
students must have Adobe Photoshop Elements installed on their computers.

Managing student projects
One way to simplify file storage and retrieval in classroom situations is to ask stu­
dents to create a folder on their hard disks, name it [Student’s] Lessons (substitut­
ing the student’s actual name for “Student”), and then copy each project folder into 
the main Lessons folder. Having students keep all their working files in their own 
Lessons folder makes it easy for you to clean up files when a class is over. 

New Features
By far the biggest new feature in Adobe Premiere Elements 9 is the ability to run 
on the Macintosh platform. The interface is very, very similar on the Mac and 
Windows, so you should be able to teach students running both platforms in a 
single class. Several lessons introduce new features in Adobe Premiere Elements 9:

•	 Lesson 2 details how to work with Adobe Premiere Elements dynamic 
sequence preset, which is a great way to ensure that project presets match 
your source footage. 

•	 Lesson 3 introduces an enhanced interface for capturing from Flip/AVCHD 
and other similar devices. 

•	 Lesson 6 introduces the ability to render a work area, and a new Cartoon effect. 

•	 Lesson 11 describes how to create a WebDVD.  

Getting Started
Before beginning Lesson 1, you should decide how to handle the issue of software 
and lesson file installation from the CIB DVD to the student computers. You may 
wish to prepare lesson folders for your students before the first classroom session, 
or teach this procedure, along with the creation of work folders and initial catalog 
files, as part of Lesson 1. 

Note that the only essential procedure found in Getting Started that is not covered 
in Lesson 1 is reconnecting missing files to a project. 
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Lesson 1: The World of Digital Video
This lesson introduces how students will use Adobe Premiere Elements to pro­
duce movies and previews the key panels, workspaces, and views they’ll use in 
Adobe Premiere Elements. Students will also learn the benefits of subscribing 
to Adobe Photoshop.com. 

In a classroom situation, it would be best to complete the Getting Started section 
before you begin these lessons. 

Goals for this lesson
The objective for Lesson 1 is to familiarize your students with the Adobe Premiere 
Elements user interface so they can locate the commands and controls they’ll need 
to import and edit various content types into their movies. 

•	 They should be able to load a project or start a new project. 

•	 They should be able to identify and locate the key elements of the interface, 
including menus; the Monitor, Tasks and My Project panels; and the workspaces 
within the Tasks panel. 

•	 They should be able to understand how to back up content to Photoshop.com.

Opening discussion
Your students undoubtedly will be anxious to start editing their videos, but also a 
bit apprehensive about learning a new program. Let them know that the first two 
lessons will be introductory but that, starting with the third lesson, they’ll be cap­
turing video and fully editing video by the fourth lesson. 

Discuss that learning the interface and workflows will help them become more effi­
cient for all future projects. Though the activity is not as exciting as actual editing, 
it’s an essential step in mastering video editing.

How Adobe Premiere Elements fits into video production
Before opening Adobe Premiere Elements, start by discussing the movie making 
process in general, from importing content, to editing, to rendering, to final format 
for sharing. Consider reviewing the table of contents and spending a few moments 
discussing what the students will learn and accomplish in each lesson. 

Then open Adobe Premiere Elements, and Click Organize to open the Elements 
Organizer, not Adobe Premiere Elements. Note that you’ll actually create the proj­
ect in the Organizer. Try to get through this phase quickly, and advise the students 
that you’ll spend more time working in the Organizer in Chapter 4. 
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Once in Adobe Premiere Elements, walk each student through the following steps 
to ensure a consistent interface:

1	 Choose Window > Restore Workspace, to restore the workspace to the default 
configuration. 

2	 Choose Window > Show Docking Headers to open the headers. 

3	 Click the Sceneline button on the top left of the My Project panel to make sure 
all students are viewing the Sceneline. 

Then, begin a general tour of the workspace, including the menu bar, the Monitor 
panel, the Tasks panel and My Project panel. It’s best if you adapt the language used 
in the book and in the help file so the students learn consistent terminology. For 
example, resist the urge to call the Monitor panel the “preview panel.”

Orient the students as to how the interface facilitates the project workflow that you 
just discussed in the table of contents. Point out that students will import content 
from the Tasks panel (show the Get Media icon), edit in the My Project panel, and 
preview (and perform some titling and menu creation functions) in the Monitor 
panel. Then move to a discussion of the individual panels. 

Remember, this lesson is just a quick fly-by, not an intense, getting-acquainted  
section. Assure the students that they’ll spend much more time in each panel in 
later lessons. 

Monitor panel 
Point the students to the Monitor panel. Note that its key function is to preview the 
edits performed in the My Project panel. Ask the students to turn down the volume 
on their speakers to avoid distraction as you do the same. 

Working along with the students, click the first clip in the Sceneline, and then 
click the Play button. Let the video play for a few moments, and then click Pause. 
Discuss that the controls are similar to a typical VCR or computer video player. 

Have your students drag the current time indicator around the scene, observing 
that this is the actual edit point in the video. Ask the students to leave the current 
time indicator positioned near the end of the clip. 

Then, along with the students, drag the Shuttle controller to the left, initially about 
halfway to the edge to move the video slowly, and then all the way to the edge to 
move the video more quickly. 

Identify the icons at the lower-right of the screen for splitting the clip, adding text, 
and grabbing a frame. Hover your pointer over each icon to show its tool tip. 

Right-click within the Monitor and show the Magnification settings, which control 
the size of the video previewed in the Monitor. Make sure that it’s set to 100%. 
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My Project panel
Point your students toward the My Project panel. Identify the two workspaces: 
the Timeline and Sceneline. Describe each workspace, toggle between the two, 
and have your students do the same. 

You’ll discuss the advantages and disadvantages of both interfaces in Lesson 5, 
so hold off on that for now. 

Tasks panel
The Tasks panel is the central location for adding and organizing media; finding, 
applying, and adjusting effects and transitions; creating DVD and Blu-ray disc menus; 
and sharing finished projects. It’s where students will import their own content and 
locate content that installs with the application. In most instances, it’s also where the 
student will find the controls to adjust effects, transitions, titles, and menus. 

Working with the students, click the four workspaces: Organize, then Edit, then 
Disc Menus, and, finally, Share. Then click Organize and review the functions of 
each view:

•	 Get Media—for capture and importing content. 

•	 Media—to access content in the Elements Organizer.

•	 InstantMovie—for creating InstantMovies. 

•	 Project—to view, sort, and select captured and imported media. Working with 
the students, double-click the top video to load it into the preview window, 
and play the video. Then, click the Icon and List icons on the bottom left of the 
Project view to switch between these two views. 

Then, open the Edit workspace. Inform students that this is where they’ll find and 
customize all content installed with Adobe Premiere Elements, including themes, 
titles, transitions, and effects. Review the functions of each view: 

•	 Effects view—to view video and audio effects and presets. Use the scroll bar 
on the right to drag through all the effects, and mention that you’ll apply and 
customize the filters in Lesson 6. 

•	 Transitions view—Show all transitions, and tell the students that they’ll apply 
and customize transitions in Lesson 7. 

•	 Titles view—Ask the students to click the Title view. Explain that Adobe 
Premiere Elements supplies “families” of titles that provide a consistent look 
throughout a production. Students will apply and customize titles in Lesson 9. 

•	 Themes view—to display movie themes. Ask the students to click and preview 
a theme (with volume lowered) and explain that themes are templates that 
include effects, music, titles, and other content used to quickly create polished 
movies. Students will apply themes in Lessons 4 and 11. 



10  Instructor Notes

•	 Clip Art view—contains the clip art included with the program. Click through 
the categories to familiarize the students with the content. 

•	 Properties view—Click the first video in the project, and then click the Edit 
effects button at the lower left of the view. Observe that the five effects—Image 
Control, Motion, Opacity, Volume and Balance—are “fixed effects” that are 
present for all videos, while other effects in the Effects view must be applied. 
Note that this is also how you access the customization screen for effects that 
you apply manually. 

With the students, click into the Disc Menus workspace. Explain that this is where 
the students will choose and customize menus for their disc-based content. 

Then, ask the students to click the Share workspace, and briefly identify the five 
output options there. 

Working with Photoshop.com
Photoshop.com is a service from Adobe that’s available only to users located within 
the continental US. Explain the free and subscription options, and that the benefits 
of the latter include more storage space, additional content, and tutorials. 

If students would like to sign up for Photoshop.com, recommend that they do so 
from home to avoid consuming any class time. 

Questions
1 	 What’s the difference between Tagging and Smart Tagging?

2 	 What are fixed effects and how do you access them?

3	 Where do you click to render your movies into final format for distribution to 
friends, family, or associates? 	

Answers
1 	 Tagging is manual and very flexible; the user controls categories and manually 

tags all content. Smart Tagging is automatic, but primarily involves quality-
related criteria, as well as one or more faces in the frame. 

2 	 Fixed effects are effects that are applied automatically to all clips in a project 
and can’t be deleted. You access them by selecting the clip in the My Project 
panel, opening Effects view, and clicking the Edit Effects button. 

3 	 Click the Share workspace in the Tasks panel. 
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Lesson 2: Getting Ready to Edit
This lesson describes how to create a project, set relevant user preferences, and 
configure the interface to suit individual workflows. Depending upon your class 
schedule, you should consider teaching Lessons 1 and 2 in concert since they are 
both introductory in nature and fairly brief. 

Goals for this lesson
The objectives for this lesson are to teach your students how to choose the opti­
mal presets for their projects, to set relevant preferences, and to customize Adobe 
Premiere Elements’ application interface. 

•	 Your students should be able to access the Project Settings screen, and choose 
the optimal preset for their source video and the target output. 

•	 They should be able to recognize and diagnose settings-related issues. 

•	 Students should be able to access and choose Project preferences such as 
scratch disk location. 

•	 They should be able to drag Adobe Premiere Elements panels to a new 
configuration and then reset the workspace to the default configuration. 

Opening discussion
The key point here is that you can’t change project settings after you start edit­
ing your project. If you don’t get it right up front, and have to make a change later, 
you’ll lose all of your work. That should get the students’ attention. 

The big news here is that Adobe added a feature called dynamic sequence preset 
that tells the user if the first video added to a project doesn’t match the project set­
ting, and allows the user to change the project setting to match the clip. If you have 
students who don’t know 720p from 1080i, this is a great way to make sure that 
they’re using the right project preset. 

Setting up a new project
In this exercise, students will set up a project file for the source footage that they’ll 
be using in their projects. In class, consider creating a new project using the 
DV-Standard-48 kHz preset, which doesn’t match the 16:9 source footage used in 
the lessons included in this book. After creating the new project, import a video file 
from the DVD (content from any lesson will do) and then drag the video to the My 
Project panel. 

You should see the Mismatched Project Setting Preset window, which will allow the 
user to match the preset with the source footage. Choose No. 
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Observe how, in the Monitor, Adobe Premiere Elements places black bars on the 
top and bottom of the clip to fit the 16:9 video into the 4:3 workspace. Then, create 
a new project using the same DV-Standard-48 kHz preset, import the same video 
file, and choose Yes in the Mismatched Project Setting Preset dialog. Observe that 
the black bars are gone, and reinforce the point that if the student sees black bars 
in a video file, they probably have chosen the wrong preset. 

Ask the students to identify the camcorders that they’ll be using for their own  
productions, and then discuss the optimal preset for their content. 

Working with project preferences
In this exercise, students configure various Adobe Premiere Elements preferences. 
Discuss the importance of each preset as you examine them, and make the point 
that changing most preferences is applied prospectively, not retroactively. That is, 
if you change the default transition duration, it changes only transitions that you 
apply after making the change, not those you have already inserted into the project. 

Customizing the workspace
This exercise walks the student through the customization options for their work­
space. Make the point that they probably will reposition their interface elements 
frequently while creating a project; for example, maximizing the size of the Monitor 
panel while customizing effects, and boosting the size of the My Project panel when 
adding titles and other content to the Timeline. Finally, reinforce that the student can 
easily restore the default workspace by choosing Window > Restore Workspace. 

Homework assignment
Ask students to create a project at home using the best preset for their source footage 
and to input some video from that source. Ask them to write down their experiences to 
briefly recount which preset they used and whether they experienced any problems. 

Mixed Format Project

Though not covered in the book, some students may ask about mixed format proj­
ects that combine widescreen DV and HDV (or AVCHD) footage. In these situa­
tions, the preset strategy should depend upon the output target. 

That is, if producing for SD DVD, use a DV preset. Import the HDV footage as nor­
mal, and when you add the HDV footage to the My Project panel, Adobe Premiere 
Elements will automatically scale it to the lower resolution. 

If producing for Blu-ray disc output, or any other HD format, use an HDV project 
preset. Import the DV footage as normal, and when you add it to the My Project 
panel, Adobe Premiere Elements will automatically scale it to the higher resolution. 
The video may look a bit grainy because of this scaling, but that’s an unavoidable 
artifact of the process. 
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Questions 
1	 If you change the preferences value for transitions, which transitions 

are affected? 

2	 What are scratch discs, and why is it important to know their locations? 

Answers
1	 Changing preferences for transitions (and any other content) effects only those 

transitions that are applied after the preference change, not transitions that are 
already included in the project. 

2	 Scratch disks store content captured or created while producing a movie. It’s 
important to know their locations so you can ensure that you have sufficient 
storage space available during a project and also to enable you to delete the 
content once you’ve finished editing. 

Lesson 3: Video Capture and Import
Lesson 3 describes how to capture and import video from camcorders and other 
devices into Adobe Premiere Elements. Exercises detail how to connect a cam­
corder to a PC; how to use Video Importer to import content from various devices; 
and how to import audio, video, or still images from hard drives. 

A project file is not provided with this chapter, though the final lesson does walk 
the student through importing content from a folder on her computer. Capture is 
very device specific, and you should consider how to best illustrate this in a class 
setting when students have a wide variety of video devices, or have no classroom 
access to any device. 

Note that two basic capture interfaces are discussed, one for tape (DV, HDV), and 
one for clip-based devices (AVCHD, DVD, digital still cameras, mobile phones). 
If you can demonstrate how to capture from one device using each interface type, 
your students should be well equipped for whatever formats they may encounter. 

When planning this lesson, be sure to check the capabilities of the computers that 
you and the students will be using. Nearly all modern computers have USB ports, 
but far fewer also have IEEE 1394 (FireWire) ports. 

Goals for this lesson
The objectives for Lesson 3 are to enable students to ingest footage from multiple 
sources into Adobe Premiere Elements, using multiple connections. 

•	 Your students should understand how to connect a camcorder to a computer 
PC for ingesting content. 
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•	 They should know which technique to use to capture their source footage.

•	 Beyond capturing from a camcorder, students should know how to import DVD 
video, digital pictures, and video from a digital camera or cell phone. 

•	 They should know how to import video stored on a hard drive into an Adobe 
Premiere Elements project. 

Getting started
Your students will have to create a project to complete this lesson. The project 
preset they choose should conform to whichever format they intend to import. For 
example, if they plan to import the video included on the DVD, they should use 
AVCHD LITE 720p 30 preset. If they plan to capture HDV, use the HDV preset. 

The easiest way to involve students is to capture video from a digital camera (virtu­
ally all digital cameras shoot video). Ask the students to bring their cameras and 
USB cables to class to connect their devices to their classroom computers. 

Review the details of the System setup sidebar to make sure students understand 
what’s needed in a capture/editing station. 

Opening discussion
Make the point that capture setup and workflow is very device specific. If you can, 
try to preserve some time at the end of the class to address student-specific sce­
narios, and encourage the students to ask about their unique setups. 

Capture interfaces
Open the Organize workspace, and click the Get Media icon. Note that eight 
capture options are available, but really only two capture interfaces, the Capture 
window (click the DV Camcorder button) and the Video Importer (click the Flip, 
avCHD, Cameras and Phones button). 

Identify the source devices during class and discuss how the student should pro­
ceed if the capture source device isn’t specifically addressed. For example, if captur­
ing DV in class, make the point that HDV is nearly identical. 

Capturing tape-based or live video
Walk the students through the steps of connecting to a computer to a DV or HDV 
camcorder. Be sure to review the difference between 4-pin and 6-pin IEEE 1394 
connectors and advise students to get a cable that matches their hardware. For 
example, while most desktop computers supporting IEEE 1394 use 6-pin connec­
tors, most notebooks that do so use 4-pin connectors. Virtually all camcorders 
use a 4-pin connector, so if a student is capturing to a notebook, he would need a 
4-pin/4-pin cable. 
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Review the various capture options, especially scene detection and Smart Tagging. 
If using a DV or HDV camcorder, establish device control within Adobe Premiere 
Elements and capture some video. 

Many things can go wrong during capture, so you should be very familiar with the 
process and be able to debug it on your capture station before conducting your class. 

Using the Video Importer
This lesson is straightforward, and can be performed with a digital camera, 
AVCHD camcorder, or DVD. At step 8, have your students preview one or two 
video files before ingest. 

Importing content from your hard disk
This is the one exercise that all students should be able to perform. Unfortunately, 
it’s not a very rewarding learning experience. 

Questions
1	 What devices typically use an IEEE 1394 cable to connect to a computer? 

2	 What devices typically use USB? 

3	 How can you locate where Adobe Premiere Elements is storing your 
captured video? 

Answers
1	 DV and HDV camcorders. 

2	 AVCHD camcorders and digital cameras. 

3	 You can choose a scratch disk in Preferences.	

Lesson 4: Organizing Your Content
Lesson 4 introduces students to the two organizational workspaces in Adobe 
Premiere Elements: the My Project panel in the Organizer and Project view in the 
Edit workspace. Students learn when to use each workspace, and dive into Adobe 
Premiere Elements’ Smart Tagging and InstantMovie functionality. Students cus­
tomize and create an InstantMovie as part of this lesson. 
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Goals for this lesson
The objectives for Lesson 4 are to familiarize students with Adobe Premiere 
Elements’ main content workspaces, the Elements Organizer, and Media and 
Project views in the Organize workspace; and to explore Smart Tagging and 
InstantMovies; and to detail how to work with the Auto-Analyzer function. 

•	 Your student should understand the fundamental differences between the 
Media and Project view, and when to use each. 

•	 They should be able to manually tag their clips in the Organizer, and to apply 
Smart Tagging. 

•	 They should be able to enable and disable the Auto-Analyzer function. 

•	 Your students should be able to create an InstantMovie using manual and 
Smart Tagging. 

•	 Your students should be able to create an Album in which to back up data to 
Photoshop.com. 

•	 They should be able to drag content from either view into the My Project panel. 

Getting started
The number of goals immediately indicates that this chapter contains lots of mate­
rial. Unfortunately, while organizing content never quite sounds as exciting as 
trimming, cutting, and adding effects, the skills in this chapter are fundamental to 
efficient editing, and central to the valuable organizational capabilities of Adobe 
Premiere Elements. 

It is absolutely critical that students complete this lesson with a clear understand­
ing of the content contained in Organizer and Media and Project views, and when 
and how to use each view. When studying the Elements Organizer, they should 
grasp the benefits of the Auto-Analyzer, including Smart Tagging, and how and 
why to apply manual Tagging. 

They should understand the difference between the content in the Media and 
Project views, which is subtle but important. Simply stated, the Media view lets you 
search through all content in the Organizer, while the Project view contains only 
the content included in the project they’re currently working on. 

For most other lessons, simply working through the exercises can transfer the criti­
cal knowledge. In this lesson, however, the instructor must synthesize the exercises 
into high-level concepts to ensure that students “get it.” In this regard, the instruc­
tor may want to spend a bit more prep time working through this lesson. 
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Opening discussion
Organization sounds boring, but it’s essential to efficient editing. Adobe Premiere 
Elements has three interfaces that help producers work more efficiently. 

The Elements Organizer is the master organization tool for collecting and tagging 
and then deploying all still image, video and music content loaded on the com­
puter. The Organizer contains functions like Smart Tags that can cut down movie 
creation time to mere minutes. It’s also invaluable for finding content to use in 
subsequent projects, and for backing up content to Photoshop.com. 

The Media view is a window into the content stored in the Organizer, with most of 
the searching features, but a limited tagging capabilities. You also can’t manually 
sort content in this view, or trim or split content, though you can do this after you 
add content to the My Project panel. 

The Project view contains all the content imported into the project, and it offers 
features like trimming. Unfortunately, in the Project view, you can’t select content 
using the tags that you’ve assigned in the Organizer, or using Smart Tagging. So, 
it’s important for students to clearly understand the features of each workspace, 
and how and when to use them. 

Working in the Organize Workspace
This section describes the differences between the Media and Project views in 
Premiere Elements’ Organize workspace. 

The Media view tends to change every time you open the program (or import con­
tent) while the Project view stays consistent at all times. You can add content to the 
My Project panel from either view. When you do so from the Media view, Adobe 
Premiere Elements inserts the content into the Project view.

Finding Clips in Media View 
This section works through the search capabilities in the Media View and finishes 
by detailing how to add clips to the project. 

Tagging in the Organizer
Open the Elements Organizer and define the “big picture” benefits of manual 
and Smart Tagging (via the Auto-Analyzer) which include the easy ability to find 
relevant content and automated functions like Smart Trim, SmartFix and creating 
Instant Movies. After this explanation, the lessons regarding manual tagging are 
straightforward and can be worked through quickly. 
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Running the Auto Analyzer
Detail how to manually run the Auto Analyzer, and detail what it does. Then review 
the information that it collects and how it drives functions like Smart Trim and 
SmartFix and enhances the InstantMovie functions. 

However, advise the students that on underpowered computers with slow CPUs 
or limited RAM, the Auto Analyzer running in the background could make the 
computer sluggish or unstable, particularly when working with HD source foot­
age. Be sure to review how to disable this function in the Elements Organizer 
Preferences window. 

Creating an InstantMovie
This is the payoff, and the exercise is fun and fast. At some point, make these points 
about what an InstantMovie does and doesn’t do. 

•	 InstantMovie creates a music video using the clips you’ve selected via Tagging 
and Smart Tagging. If there’s dialog you’re hoping to maintain, forget it. You 
can’t tell a story with an InstantMovie, but you can create a short, fun montage 
that showcases a trip or event. 

•	 You can use an InstantMovie as a section of a larger production. For example, if 
you are producing a wedding video, you could include the ceremony and toasts 
in their entireties, and use an InstantMovie to depict the reception or parties. 

•	 When creating an InstantMovie, you can’t trim or edit the clips in advance 
hand. You just select or deselect them. You can edit the InstantMovie after it’s 
created (show the students how to do this), but this might throw off the tempo 
and timing. If you want more control, apply a Theme to clips on the Timeline 
(discussed in Lesson 10). 

Uploading files to Photoshop.com
This is an easy exercise that students can conveniently perform at home. 

Working with Project view
These exercises are fast and simple. Make sure to discuss both Icon and List views.	

Trimming a clip in the Preview panel
This is a nice feature for advanced editors who want to cut away unnecessary foot­
age as quickly as possible. Make the point that the student will learn many more 
ways to trim project content in Lesson 5. 
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Questions
1	 Ask the students about the utility of the Elements Organizer. For students who 

work with pictures and video, ask how many would invest the time for manual 
tagging. Ask questions to make sure they understand the utility of the Auto-
Analyzer function, and when to consider disabling it. 

2	 Set up a discussion about the Project view versus the Media view. Ask about the 
pluses and the minuses of each. 

3	 What are the advantages and disadvantages of InstantMovies vs. applying a 
Theme to content on the Timeline? 

Answers
1	 Utility of the Elements Organizer

•	 Allows users to create manual and smart albums for synchronization with 
Photoshop.com. 

•	 A great starting point for projects using disk-based assets, especially where 
you need to search through a number of files to find the right ones. 

•	 The Auto-Analyzer produces Smart Tags used for Smart Trim, SmartFix, 
and creating InstantMovies, along with providing tags that students can use 
to find or eliminate certain classes of content, like shots with faces or shaky 
or low quality footage. 

•	 While analyzing clips, the Auto-Analyzer consumes lots of system resources. 
Consider disabling if editing becomes unresponsive or if the system 
becomes unstable. 

2	 Project view advantages:

•	 Contains all project content; never changes

•	 Nice interface for creating a rough cut and trimming content before adding 
to the My Project panel

Project view disadvantages

•	 Can’t access tagging or Smart Tagging info

•	 Very little sorting or search capabilities. 

Media view advantages:

•	 Great search capabilities, the ability to access all the content in the Organizer. 

Media view disadvantages

•	 Can’t edit or sequence clips in the Media view. 

•	 Content changes frequently during the course of the project, which can 
be confusing. 
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3	 InstantMovies can use clips selected via Tagging and Smart Tagging in the 
Organizer. You apply Themes to clips on the Timeline. You could also select 
clips via Tagging and Smart Tagging in the Organizer, drag them to the 
Timeline, and then apply a Theme. 

When using InstantMovies, you have no real editing input beyond selecting 
the clips to include. You can cut out portions of any clip that you don’t want 
included before applying a Theme. 

Lesson 5: Editing Video
Lesson 5 introduces students to Adobe Premiere Elements’ Timeline and Sceneline, 
and to fundamental editing tasks like inserting, deleting, splitting, and rearrang­
ing clips in the Sceneline and Timeline. It also introduces the student to Adobe 
Premiere Elements time saving feature, Smart Trim. 

Goals for this lesson
The objectives for Lesson 5 are to enable students to perform basic editing tasks in 
both the Sceneline and Timeline. 

•	 Your student should appreciate that trimming, cutting, splitting, and deleting 
video is fundamental to creating high-quality, watchable movies. 

•	 Your student should understand how to use Smart Trim mode to quickly 
remove lower-quality segments from their videos. 

•	 They should understand the difference between the Sceneline and Timeline; 
when to use each; and how to insert, move, trim, split, and delete clips in each. 

•	 Your students should become very capable with the Monitor panel in both the 
Sceneline and Timeline. 

•	 They should learn keyboard shortcuts to speed their editing. 

Getting started
Basic editing skills, such as those taught in this chapter, are the most important 
fundamentals that students can learn. This chapter is long, with lots of material to 
process. In a classroom setting, you should consider dropping the section on the 
Sceneline and move directly to the Timeline.  

Opening discussion 
For the movie Gone with the Wind, IMDB reports that over 500,000 feet of film was 
shot, but only 20,000 feet was used in the actual production, about 4% of the total 
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footage. While your students probably won’t cut that much from their productions, 
it’s important to stress that the best way to make a movie watchable is to cut as 
much footage as possible. 

Though it’s hard to imagine that GTWT director Victor Fleming lived by this creed 
(the movie was 226 minutes long), shorter is almost always better for personal and 
business-related movies. As a result, skills learned during this lesson are critical to 
producing watchable films. 

Setting up your DV hardware
Students working with DV source footage can preview their videos on a televi­
sion set or other NTSC monitor connected to their camcorders. When producing 
for DVD, this provides a more accurate preview than using a computer monitor 
because the NTSC device displays colors differently. Discuss this with the class and 
ask the students if their editing setups will include a NTSC TV. 

Working with the Monitor panel
You and your class may be tempted to skip through this section because it’s so 
basic, but students should use each control to identify its function. In class, per­
form each step of the exercise with the students to ensure their comprehension. 

You should also describe what rendering is, why it’s important sometimes (and why 
it’s not important for all edits), and how to render a work area of the timeline. 

Working with the MyProject panel in the Sceneline
For this exercise, consider having the students delete the last five clips, and then 
add them back to the project. You should have touched on the Sceneline in previ­
ous lessons. Reiterate its advantages:

•	 Simple to understand (if you can create slideshow, you can create a movie). 

•	 Very easy to shift content around. 

And its disadvantages:

•	 Somewhat cumbersome when you have placed multiple clips at the same spot in 
the project (layered clips). 

•	 Cumbersome when you are using content that spans more than one piece of 
content, like a background music track, or title above multiple clips. 

Emphasize skills learned during the trimming and splitting sections. Observe that 
splitting is a key skill even when capturing with scene detection enabled because 
producers often have to carve multiple scenes out of a single clip. 

Working through the exercises should be straightforward. 
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Working with the My Project panel in the Timeline
For this lesson, consider having the students delete the last five clips, and then add 
them back to the project. You should have touched on the Timeline in previous les­
sons. Reiterate its advantages:

•	 Offers the best visualization when using multiple layers, or when adding content 
that spans the duration of other content (such as background music). 

•	 Can easily view the duration of each section and the entire movie. 

And its disadvantage:

•	 Not as intuitive as the Sceneline.

Note the keyboard shortcuts that are mentioned in step 4 of the first exercise. 
Review these in detail because their use will simplify navigation in all future edits. 

Emphasize skills learned during the trimming and splitting sections. Observe that 
splitting is a key skill even when capturing with scene detection because often pro­
ducers have to carve multiple scenes out of a single clip. 

Working in Smart Trim Mode
Smart Trim is a feature of Adobe Premiere Elements 9 that automatically identi­
fies regions with quality issues. You should take the time to review both modes of 
operation—manual and automatic—and discuss when to use each. 

If you’re relying heavily on the sample assets on the DVD, make the point that 
because of disc space limits on the disc, most bad footage was chopped out manu­
ally while creating the project. For this reason, Smart Trim may not appear to be as 
valuable as it would be with most original source footage. 

If you can find some other source footage to use to demonstrate Smart Trim, it might 
better represent the value this feature offers to Adobe Premiere Elements users. 

Creating a Slide Show
This is a fun exercise for students working with lots of still images and video. 

Questions
1	  Compare the pros and cons of the Timeline and the Sceneline and under what 

circumstances can each be put to best use?

2	 Identify the most important keyboard shortcuts for Timeline use. 

3	 What are the two modes available in Smart Trim mode, and when would you 
use each? 
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Answers
1	 The Sceneline has the advantage during the early stages of a project, when 

you’re adding, splitting and rearranging content. Timeline is best when you start 
refining the project, especially when you start adding layers of content. 

Overall, the Timeline is more capable than the Sceneline, and most advanced 
editors work exclusively in the Timeline. That said, the Sceneline is useful until 
you become more familiar with Premiere Elements and the editing workflow. 

2	 Timeline keyboard shortcuts:

•	 Play/pause—space bar

•	 Arrow keys—frame by frame forward/back

•	 =/- keys—zoom in/out on the timeline

•	 / (backslash) fit entire video on the timeline

3 	 The two Smart Trim operating modes are manual, which identifies problem 
areas and lets the editor trim them out, and automatic, which deletes all 
problem areas. Probably best if students use manual mode until they’re 
comfortable that automatic mode won’t delete some clips that might be 
technically low quality but nonetheless essential to the production. 

	 You know, like that moving shot where you follow your spouse in from the 
kitchen carrying the birthday cake with candles. Smart Trim might identify this 
as shaky, but you probably want to leave it in nonetheless. 

Lesson 6: Working with Effects
In Lesson 6 students will learn the difference between curative and artistic effects, 
and when and how to apply them. 

Goals for this lesson
The objectives for Lesson 6 are to enable students to apply and configure curative 
and other effects in Adobe Premiere Elements. 

•	 Your students should understand the types of effects, including curative and 
artistic. They should also understand how SmartFix works and the benefits of 
this feature. 

•	 They should know how to adjust brightness and contrast, adjust color balance 
and fix backlighting, and adjust clip position using Motion controls. 

•	 Your students should be able to customize effects with key frames, and copy and 
paste effects between clips. 
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•	 Time permitting, students should learn how to create a picture-in-picture effect, 
and how to composite one video over another using Videomerge. 

•	 If your class is sufficiently advanced, and you have the time, you might discuss 
when and how to apply Motion Tracking to a clip, and how to use Effect Masking. 

Getting started
This is another lengthy lesson. Many sections are conceptually difficult, yet very impor­
tant to successful editing. It is important that you choose the most important subjects 
to discuss, and make sure that you have enough time to teach them effectively. 

Fortunately, students can perform several exercises at home because they explore 
discrete skills in and of themselves with no broad applicability. For this reason, you 
might consider assigning the last four exercises—Picture-in-Picture, Videomerge, 
Motion Tracking and Effect Masking—as homework, or describe them early on as 
topics that you’ll get to only if time permits.

Another approach might be to exclude some advanced topics, such as control­
ling effects using keyframes. This is an incredibly powerful and important feature 
of Adobe Premiere Elements, but it is also a feature that may be difficult for some 
students to grasp in 5-10 minutes. 

Finally, because the Lesson 7 is much shorter and simpler than Lesson 6, you may be 
able to extend some of the effects-related training into the following class period. 

Opening discussion 
When most beginning editors hear the word effects, they immediately think of 
Spielberg and Star Wars. But some of the most important effects are those that fix 
errors made during shooting, such as shooting with insufficient lighting, forgetting 
to white balance the camcorder, or falling victim to strong backlighting. You can’t 
have good video, after all, without good video quality. Fortunately, Adobe Premiere 
Elements has outstanding tools to correct all of these problems. 

After applying these curative effects, students will have time to get creative. 
Adobe Premiere Elements has plenty of artistic effects, and they can really perk 
up a production. 

Using effects
Here’s where you can elaborate on the difference between curative and creative 
effects. Be sure to touch on all types of effects. Even if you lack the time to describe 
them all, the students should know that they exist. 

Students should learn how to access and use the fixed effects in the Effect 
Properties view, a resource that is often hard for newbies to find. They can locate it 
using one of three methods: choose Window > Properties in Effects view, click the 
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Properties Button at the upper left of the timeline, or choose Edit Effects in Effects 
view. Review all three methods with your class several times so they the Effect 
Properties view when they need to. 

Working with SmartFix
SmartFix is a mode that automatically corrects shaky and poorly exposed video, 
but relies upon Smart Tag information gathered by the Auto-Analyzer. SmartFix is 
almost always helpful, so your students should definitely learn how to use it. 

Perfecting your clips
The first two sections in this category—Applying and resetting fixed effects and 
Reframing a clip using Motion controls are essential skills, and should be covered 
thoroughly.

Rendering effects is a skill that students may not need to know because the near-
real-time preview that is available without rendering provides sufficient quality for 
most projects and editors. This could be assigned as a “learn at home” section if 
you’re short on time. 

Choosing and applying effects
These sections are all fairly important, particularly “Fixing back lighted video” and 
“Stabilizing shaky footage.” Adobe Premiere Elements’ Shadow Highlight filter has 
bailed out this author more times than he cares to admit, and the Stabilize feature 
has also come in handy. These are great skills to learn. 

One very useful feature in Adobe Premiere Elements 9 is the ability to apply and 
remove effects to and from multiple clips simultaneously, detailed in a sidebar on 
page 132. You should definitely put this on your agenda. 

Rendering effects
You don’t have to render each effect before moving on, but it’s helpful to know how 
to do so. One key new feature in Adobe Premiere Elements 9 is the ability to render 
a work area. Cover rendering in general, and this new feature, in particular.  

Working with keyframes
Adobe Premiere Elements’ keyframe controls are virtually identical to those used 
by Premiere Pro, which makes them incredibly powerful, but also somewhat hard 
to learn. Let the students know this up front, and also stress that keyframes are a 
critical control mechanism for every digital content production program. The skill 
may be hard to learn, but it has broad applicability—not only in Adobe Premiere 
Elements, but in most other content creation programs as well. 
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With this buildup, working through the lessons should be anti-climactic, and 
students will grasp the concepts quickly. Don’t rush through them, though, because 
they are challenging concepts to convey and if you (or the students) miss a step, you 
won’t achieve the desired learning. If you have to skip a lesson in this section due 
to time constraints, it should be the last, Using keyframes to animate effects, which 
should be obvious after working through the previous lessons. 

Copying effects from one clip to another
The most frequent use for this procedure is to apply curative effects from one clip 
to another. That is, you shoot an indoor birthday party and later discover that the 
white balance was off and you need to boost brightness. After you perfect your first 
clip, you can copy the effects as applied to that clip and apply them to another. You 
might start this section with a question. “Who can describe a scenario in which the 
ability to copy effects from one clip to another would be valuable?” 

Other Exercises
The next two exercises—Creating a Picture-in-Picture overlay, and Compositing 
two clips using Videomerge—are both very simple and can be learned at home. As 
mentioned at the beginning of this section, you should consider allocating these to 
self-study. Changing speed using the time stretch tool is very useful, but primarily 
for advanced editors. 

Motion Tracking is one of the coolest features in Adobe Premiere Elements 9 and 
it’s relatively simple to use. If time permits, run through this exercise with the class. 
Otherwise, consider showing the class how it works on your computer but have 
them actually perform the exercise at home. 

Effects Masking is an incredibly powerful feature—I wish it was this easy in 
Premiere Pro. However, it’s probably best served to advanced users, since beginners 
might not grasp when it might be useful. 

Time permitting
If you have time to allow the students to experiment, point them toward New Blue’s 
Old Film effect, which is a great way to completely change the look and feel of a 
video. Other very cool effects include the Lighting and Earthquake effects. 

Questions
1	 Describe three ways to find the Effect Properties window. 

2	 What function must be run for SmartFix to operate? 

3	 How to you enable/disable the effect preview? 

4	 What is backlighting and what’s the best effect to correct it. 
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Answers
1	 Choose Window > Properties in Effects view, click the Properties Button at the 

upper left of the timeline, or click Edit Effects in Effects view. 

2	 SmartFix relies upon data supplied by the Auto-Analyzer, and won’t operate on 
clips that haven’t been analyzed. 

3	 In the Properties view, click the eyeball icon next to the effect. 

4	 Backlighting occurs when a bright light behind the subject causes the 
camcorder to darken the subject’s face. Adobe Premiere Elements’ Shadow 
Highlight tool is a great tool to correct this. 

Lesson 7: Working with Transitions
Lesson 7 describes how to add nuance and dimension to movies by placing transi­
tions between clips. Students will apply and preview transitions, customize transi­
tion settings, create fade-ins and fade-outs and to render transitions. 

Goals for this lesson
The objectives for Lesson 7 are to enable students to apply and configure transi­
tions in Adobe Premiere Elements. 

•	 Your students should understand when and how to use transitions. 

•	 They should be able to open Transitions view and to preview transitions. 

•	 Your students should be able to customize transitions. 

•	 Your students should be able to apply the default transition to multiple clips. 

•	 They should understand how to render transitions. 

Getting started
This lesson could be short and sweet, if desired, and you should have no trouble 
working through the individual exercises in a reasonable amount of time. As such, 
you may wish to devote a portion of your Lesson 7 time to follow-up on any linger­
ing issues from Lesson 6. 

Opening discussion 
Let’s face it; applying transitions is pretty routine. You drag transitions between the 
two clips and move on to the next edit. As such, the best knowledge you could pass 
on to the students is when and how to use those transitions. 
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In this regard, consider starting the class with a discussion of four types of 
productions: 

•	 A variety show that employs frequent cuts between multiple cameras (such as 
The Late Show with David Letterman) 

•	 A movie (pick one that’s considered artsy). 

•	 A children’s show (such as Barney & Friends or The Wiggles for the diaper set, or 
iCarly or Hannah Montana for older children) 

•	 A sports show (such as ESPN’s Monday Night Football) 

Discuss how each show uses transitions and make the following points:

•	 You don’t need to insert transitions between all clips. In The Late Show, when 
cutting from one camera to another, you don’t need a transition effect (and 
mention the obvious corollary that a transition isn’t necessary between every 
two clips on the timeline). Make the point that a cut is a transition in and of 
itself, but no effect is applied. 

•	 Transitions should be used between changes in place and time. In most movies, 
transitions are typically used between major scenes to suggest that some change 
of time or place is occurring. For example, in Slumdog Millionaire, an excellent 
example is when the two boys are pulled from a rolling train, roll into a dust 
cloud, and then reappear as young teenagers. The transition was necessary 
because moving from childhood to adolescence would otherwise have appeared 
disjointed. However, when cutting from camera angle to camera angle within 
the same scene, no transition effects are necessary. Make the point that most 
movies have only two types of transitions; dissolves between minor scene 
changes and fades to black during major scene changes. 

•	 Transitions should match the tone of the movie. In a show such as Barney or 
iCarly, transitions are frequently used (usually only between scenes, and not 
within scenes), but they’re fun transitions added to match the playful tone of the 
show. Transitions should always match the tone of the event. 

•	 Transitions can also be used as branding. Monday Night Football uses branded 
transitions to jump from disparate scene to another (such as cutting from the 
scoreboard to an announcer, or jumping from instant replay to live action.) 
Make the point that all transitions should be “motivated.” The motivation is 
usually to avoid viewer confusion, but sometimes transitions are used to realize 
a high-concept visual style or to communicate branding. 

•	 Transitions are hard to compress for streaming. Also make the point that a 
transition that looks great on DVD, such as a one second fade to black, may 
look awful when compressed for streaming, simply because the compression 
ratio must be set much higher for streaming media. 
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A rule of thumb is to use one-second transitions for DVD and other high data 
rate outputs, and half-second transitions in projects intended as streaming media. 
Remind students that they can change the default duration in the Preferences 
view (choose Edit > Preferences) but that the changes are applied prospectively, 
and will not be applied to transitions already located in the Timeline. 

Using the Transitions view in the Tasks panel
This is a straightforward exercise to point out that Adobe Premiere Elements lets 
you add transitions to a Favorites category, which students should populate with 
their favorite transitions. 

Applying transition/viewing transition properties
Like the Effect properties window, the transition Properties window can be hard 
to find. You can get there using one of three methods: click the transition and click 
the Properties button on the top left of the Timeline, open the Transitions view 
and choose Window > Properties, or open the Properties view and click the Edit 
Transition button.

Modifying transition settings
Make the point that not all transitions have customization options beyond duration 
time, and that transition customization relates to duration 99 percent of the time. 

Adding a single-sided transition to create a fade-in
Emphasize that this is probably the easiest way to add a fade-in to a clip, but it’s 
also the least customizable, with control over duration only. For superior control 
over all aspects of the fade-in, the student should use the Opacity controls on the 
timeline, which are fully keyframeable. You can apply these in the Effects Properties 
window (using the Fade-in/Fade out icons) or apply them manually in the Timeline. 

Applying the Default Transition to Multiple Clips
This is a killer time saving feature that you should definitely cover. 

Questions
1	 Describe the three ways to open the transition Properties window. 

2	 What’s the best transition duration to use for streaming and why? 

3	 What are the four most highly used transitions in TV and the movies? 

4	 Can you get arrested for making a movie without transitions? 
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Answers
1	 Click the transition and click the Properties button on the top left of the 

Timeline, open the Transitions view and choose Window > Properties, or open 
the Properties view and click the Edit Transition button. 

2	 Use a half-second transition duration because it typically reveals fewer 
compression artifacts than one-second durations. 

3	 Cuts (no transition effect), dissolves, and fade to and from black.

4	 No, in fact many in the style police encourage this practice. 

Lesson 8: Titles and Credits
Lesson 8 details Adobe Premiere Elements’ title functionality. Students create origi­
nal titles and rolling credits for their productions, and use title templates they are 
installed with the program. 

Goals for this lesson
The objectives for Lesson 8 are to teach students how to create titles in Adobe 
Premiere Elements. 

•	 Your students should understand the differences between full screen and 
overlay titles, and how to create each title type. 

•	 Students should know how to access and customize the title creation tools for 
text and design primitives. 

•	 Your students should be able to create and customize rolling titles. 

•	 Students should be able to access, apply, and customize title templates. 

Getting started
Most students already understand how to create and modify text, so this lesson is 
relatively straightforward to teach. However, concepts such as kerning and lead-
ing, which are essential to title design, may be foreign to students, so plan to invest 
some time to clarify these concepts during class. 

The most complicated activity is creating rolling credits. Because this is something 
most students eventually will want to do, be sure you budget sufficient time to 
cover the subject thoroughly. 

Opening discussion 
Titles perform many functions in a video project. Most videos start with an open­
ing title, and end with credits. During the video, titles can alert viewers when the 
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movie changes from one section to the next. They can also convey additional infor­
mation to the viewer, through subtitles or using thought bubbles. 

One great way to demonstrate that titles serve multiple purposes is to browse the 
title templates, and identify the purpose for each title type, whether list (to show 
agenda or contents), lower third (for overlay titles to identify the speaker), frame 
(opening title) or credits. 

Moving on, discuss how some video producers take a perfunctory approach to 
titles, treating them as necessary evils. However, using Adobe Premiere Elements’ 
comprehensive text tools and the ability to import graphics or display a title over 
a frame or video, producers should consider titles a valuable tool for grabbing and 
maintaining audience attention. 

As a final consideration, note that your students should at least consider the 
visual uniformity between their titles and their DVD or Blu-ray menus. At the 
very least, these elements should use the same fonts. Producers can create a very 
polished, cohesive look by using the same background images, or other similar 
design elements throughout their presentation. Note that several of the Adobe 
Premiere Elements titles have accompanying DVD menus that reflect this approach 
(European Travel, Blue Notes, Birthday). 

A couple of additional points should be mentioned early in the lesson. First, pro­
ducers can insert titles over a clip (overlay titles) or can employ full screen stand­
alone titles. They can insert overlay titles over any type of content, whether still 
image or video. Though most titles produced in this lesson will include only one 
line of text, producers can insert multiple text strings into a single title. 

After you create and insert a title, Adobe Premiere Elements treats it like a still 
image, so you can drag the title to any length, apply a transition or effect, add 
motion effects as you would to a still image, or change its opacity. 

Creating a simple title
This is an example of creating a full screen title. Work through the basic text tools 
slowly, and be sure to define kerning and leading. 

Call attention to the title-safe and action-safe margins sidebar. Emphasize that you 
don’t need to worry about these margins if the video content (such as streaming 
video) will be viewed only on a computer. Computer monitors don’t have the over­
scan issues that the action- and title-safe margins address. 

Adding an image to your title files 
Observe that you can import a full screen background image as well as a smaller 
image. Although you could accomplish a similar effect by overlaying a title over 
an image on a lower timeline track, it’s simpler to import an image because if you 
move the title at some point, the image will move with it. 
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Superimposing a title over video clips
Whenever you superimpose a title over a video clip, the most important consider­
ation is legible text, especially when the background video is moving and chang­
ing in color and brightness. To maintain design consistency, you should identify a 
single visual design that works irrespective of the background video. 

Design strategies include adding a border or background shadow to the title text,  
or, as  in the exercise, adding a translucent box or other design primitive. Note that 
these design primitives allow producers to get very creative with titles. 

Animate a still title
When teaching the material in this sidebar, make the point that these effects are sepa­
rate from the motion effects that you can apply to any still image on the timeline. 

Creating a rolling credit
As mentioned earlier, rolling credits can be complicated to produce. Consider 
using the rolling credit from the supplied project, and allowing students to experi­
ment with options such as Start off Screen, and Pre-roll, Ease-in and Postroll to 
produce different results. 

Emphasize that you control the speed of the rolling credits by setting title duration. 
Stretch the duration to make the title move slower, reduce duration to make the 
credits roll faster. 

Using title templates
Templates are great starting points when creating titles, and also wonderful tools 
for maintaining a cohesive look. Review several templates, discuss the roles for 
each title type (if you did not so during your opening comments), and briefly 
describe how to apply and customize templates. 

Then show that certain titles have identically designed DVD menus (Blue Notes, 
several birthday menus) to achieve a cohesive project appearance. 

Questions
1	 What is kerning?

2	 What is leading?

3	 What’s the primary consideration when creating an overlay title? 



Adobe Premiere Elements 9 Classroom in a Book  33

Answers
1	 Kerning is the space between text characters. 

2	 Leading is the space between text lines. 

3	 The primary consideration is ensuring text legibility. You can do this by applying 
an outline, shadows, or a translucent design primitive to the title. 

Lesson 9: Working with Sound
Lesson 9 examines multiple audio-related features, including a real time narration 
tool; the ability to create, add, and modify soundtracks; and a mixer that controls 
the volume levels within clips. To become familiar with these features, students 
create a background music track, adjust the volume of an audio clip, add sound 
effects, add a narration clip, and mix a final audio track. 

Goals for this lesson
The objectives for Lesson 9 are to enable students to create, mix, and apply effects 
to audio tracks. 

•	 Your students should understand SmartSound; how to access the libraries 
on their discs and online; and how to create custom length, theme-specific 
background music for their productions. 

•	 Your students should understand how to use Smart Mix to automatically mix 
the audio tracks in the project. 

•	 They should be able to adjust volume with the audio mixer, using rubber band 
controls on the timeline, and using Adobe Premiere Elements’ gain controls, 
which now can be applied to multiple clips simultaneously. 

•	 Your students should understand how to create narration tracks. 

•	 They should be capable of applying and customizing effects to audio files. 

Getting started
This lesson has two logistical issues to consider in advance. First, the students will 
need to hear audio tracks much more clearly for sounds mixing than for video 
editing. Whereas speakers may have worked well during video editing, headphones 
might be preferable to use for this lesson. If you don’t already have headphones 
available, you should encourage students to bring their own, even if they’re only 
iPod ear-buds. 

The second issue relates to narration. If each computer in the class doesn’t have 
a microphone, you should consider asking each student to buy an inexpensive 
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microphone for her own use, which can cost under $20. Note, however, that 
configuring individual computers to recognize and use a microphone can be time 
consuming. As an alternative, consider demonstrating how to create a narration 
track, and using the same narration track for all editing activities. 

Opening discussion 
Begin the class with a discussion of the importance and impact of audio. 

In all productions, audio must be noise free and properly mixed. As when applying 
curative effects in Lesson 6, the audio techniques taught in this lesson will improve 
the quality of audio tracks and the final audio mix. 

•	 In business productions, background music provides a general polish. 

•	 In movies, background music can help set the tone, and reinforce the emotions 
in scenes. 

•	 In home movies, background music or narration can provide the continuity that 
the typically disparate scenes lack. Play the completed movie that comes with 
this chapter without sound to make this point. Note that TV shows and movies 
have storylines and dialog that carry the viewer from start to finish, but most 
home movies don’t. A strong audio track can smooth over the lack of continuity 
in home movies. 

Background music, in particular, is a home producer’s best friend. An 
acceptable home movie without background music is just OK. An acceptable 
home movie with great background music can be a great movie. 

Creating background music with SmartSound
SmartSound is ideal for business presentations that need thematic background 
music (OK, elevator music) that most people don’t have in their personal music col­
lections. In addition, it’s also lots of fun for movies in which thematically appropri­
ate music adds a nice atmosphere. 

Students should understand that a modest number of SmartSound tracks install 
with Adobe Premiere Elements, and that the interface provides access to purchase 
songs from SmartSound’s much more extensive online collection. As an adjunct to 
the exercises, consider encouraging the students to search for music for their own 
home projects to familiarize themselves with the search tools and available tracks. 

Adding narration
This exercise covers the mechanical aspect of creating a narration track, but not the 
artistic aspect. In most instances, for best results, students should prepare a script, 
read it several times, and print it in short sections in large fonts. Scripts should be 
written to suggest the way people talk, rather than the way they write. 
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Also discuss the environmental aspects of recording a high-quality narration, mean­
ing access to a quiet room with no air conditioning/heating noise. Also identify what 
a pop filter is and why students should consider getting one for recording narration. 

Adjusting Project Volume with SmartMix
A totally cool feature and fun exercise. The exercise makes the point that you might 
have to perform some adjustments manually after applying SmartMix, and you 
should make that point as well. 

Adjusting the volume of an audio track
Before getting into volume adjustment and mixing, work through the About 
Waveforms sidebar. Examining waveforms is an excellent way to identify audio 
problems and students should become comfortable reading them before starting to 
mix or adjust audio volumes. 

Be sure that students grasp the difference between adjusting volume in the volume 
graph and adjusting the volume using the gain controls. To make the distinction, you 
can detail the difference between normalization and manual volume controls. Consider 
covering these fundamentals before actually describing how the controls work. 

One of the key differences between the volume graph and the gain controls is that you 
can adjust the gain of multiple clips simultaneously, which is a very convenient feature. 

Raising and lowering volume with keyframes
Inserting keyframes is much more intuitive and contextual in the timeline than in 
the Properties pane. Consider teaching this skill entirely in the Timeline view. 

Working with the audio mixer
Emphasize that the audio mixer is a useful tool, but it usually only creates a “first 
draft” of the final audio levels. In most instances, students will need to fine-tune the 
settings produced by the audio mixer using rubber band controls and keyframes. 

Edit to the Beat of Your Favorite Song
A very fun and useful feature for those creating slide shows from digital pictures. 
Worth demonstrating if your class includes a lot of wannabe Ken Burns (who pro­
duces movies with extensive use of still pictures with pan and zoom effects).  

Adding a sound effect
This lesson is ancillary to the other content in the lesson. Consider describing the 
difference between normalization and compression and then assigning this for 
additional home study. 
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Questions
1 	 In what situations is audio normalization hard to apply? 

2	 What’s the difference between normalization and manual volume adjustment 
and when should you use each. 

Answers
1	 Normalization works poorly in clips that have loud and soft regions, when 

the obvious objective is to raise the volume in the quieter sections. Because 
normalization is limited by the loudest sounds, normalization often does 
little to boost the volume of the quieter sounds. One alternative is to split 
the clip into high and low volume levels, and normalize the lower regions 
independently. Or, use rubber band controls to select specific areas of the audio 
track and adjust their volume manually, at the risk of introducing distortion. 

2	 Normalization boosts volume of the entire audio track to the maximum decibel 
level that doesn’t distort the loudest regions. It’s best used when the audio levels 
in the track are relatively consistent (as narrationtracks). You can adjust volume 
manually using rubber band controls or keyframes, which is a preferable option 
when an audio track includes widely varying volume levels. Manual adjustments 
can introduce distortion , however, so you should be careful when performing 
manual volume adjustments. 

Lesson 10: Working with Movie Themes
Lesson 10 describes how students can quickly apply a Movie theme to their source 
clips to produce an engaging, stylized movie in a matter of minutes. Movie Themes 
and InstantMovies are really the same creature. Although InstantMovies are 
applied in the Organizer and Movie Themes are applied in the My Project panel, 
they both use the same interface. You might consider teaching this lesson with 
Lesson 4 (see “Getting started”). 

Goals for this lesson
The objectives for Lesson 10 are to enable students to apply Themes to content in 
the My Project panel. 

•	 Your students should compare applying themes in the My Project panel to 
creating InstantMovies in the Organizer (Lesson 4) and know when to use 
each method. 

•	 Students should be able to customize Movie themes. 

•	 Your students must edit movies on the timeline after applying a Theme. 
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Getting started
This lesson could be covered adequately in less than 15 minutes. For this reason, 
you might consider teaching this lesson with the Lesson 4. The problem with cover­
ing these in Lesson 4 is that students haven’t yet learned how to get content into 
the My Project panel, so this procedure may be confusing to them. 

Otherwise, this content is sufficiently discrete that you can cover it with any other 
lesson, given sufficient time. 

Opening discussion 
Like InstantMovie (which was covered in Lesson 4), applying themes converts 
selected clips in the My Project panel into music videos. Unless you’re recording a 
sequential event (wedding, graduation, school play, ballet) or creating a movie with 
a specific story line, using themes is a great way to quickly edit clips into an engag­
ing, watchable music video. It’s impossible to include dialog, however, because 
Adobe Premiere Elements might cut off any clip at any time. Discuss the types of 
projects that may be appropriate for themes and those that are not. 

Help students understand when to apply Movie themes in the My Project panel 
and when to create InstantMovies in the Organizer. Note that the section entitled 
“About Movie themes” details these issues. 

Make the point that using these methods doesn’t have to be an either/or proposi­
tion. That is, students can use Tagging and SmartTagging to find the desired con­
tent, and drag it into the My Project panel. Then, they can edit out the undesired 
content, and apply a theme. 

Also clarify that producers can apply a Theme to all of the clips in the My Project 
panel, or just selected clips. In the context of a long form production, such as a 
wedding or graduation video, this can be an efficient way to convert short sec­
tions into a music video-like production that shows off the people and setting in an 
enjoyable manner. 

Applying a movie theme
This is a straightforward exercise. Be sure call attention to step 7, which describes 
how to break an InstantMovie apart. 

Questions
1	 What types of productions are Themes best used for? 

2	 How can you use manual Tagging and Smart Tagging with Themes? 
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Answers
1	 Themes are a great way to pull together multiple clips when the subject of 

those clips isn’t tied together by dialog (such as  a meeting) and don’t require 
sequential presentation (such as a wedding ceremony or school play.) Think of 
days at the beach, your child’s first visit to the roller skating rink, your trip to 
New York City as appropriate Theme content. 

2	 Use Tagging and Smart Tagging to identify clips to insert into the My Project 
panel, edit out what you don’t want, and then apply the Theme. 

Lesson 11: Creating Menus
Lesson 11 is aimed at students creating a Blu-ray or other optical disc from their 
projects. Students will add menu markers to videos; and how to create, customize 
and preview menus. Then, they’ll upload the results to a WebDVD, and burn the 
results to a DVD or Blu-ray disc. Because Adobe Premiere Elements can record 
a disc image to a hard drive (in addition to writing the content directly to a disc), 
your students need not have a DVD or Blu-ray recorder to perform these exercises. 

Goals for this lesson
The objectives for Lesson 11 are to enable students to burn DVD and Blu-ray discs 
from an Adobe Premiere Elements project. 

•	 Your students should understand the system requirements for creating and 
playing DVD and Blu-ray discs. 

•	 They should understand and be able to add menu markers to their movies. 

•	 Your student should know what an auto-play disc is, and how to create one. 

•	 Student should learn the techniques of creating a menu template, including 
inserting background video or images, adding background audio, and animating 
menu buttons. 

•	 Your student should be able to preview their discs, and record the project to 
WebDVD or traditional DVD or Blu-ray disc. 

Getting started
This is a long lesson, but critical for students who want to burn DVDs containing 
their content, or upload a DVD-like experience to the web. Depending upon the 
technical level of the students, some may be totally unfamiliar with the technical 
requirements of producing DVDs, so you should introduce these issues first. You 
may also have to spend significant time explaining menu markers and other disc-
development similar concepts. 
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Fortunately, some of the later sections are comparatively simple and can be worked 
through with little additional explanation. Finally, if the students have DVD or Blu-
ray burners and the necessary media, you’re good to go at the disc-making stage. 
Otherwise, fall back to plan B, which is to save a disc image on the student hard 
drives. This process is very similar to burning a DVD, the primary difference being 
that the hard drive is chosen as the destination medium in the last dialog. 

Opening Discussion 
If your students are not familiar with DVD technology, start out with a brief DVD 
primer. At a highest level, DVDs have two components, menus and content. The 
two processes of creating a DVD are adding menu markers to the content so view­
ers have input points, and building a menu. Adobe Premiere Elements does all the 
linking and encoding. 

Introduce the concept of a WebDVD, where students can create and upload a proj­
ect that will work like a DVD on the web, including clickable menus for navigation 
and video playback.  

Then, list the technical requirements for producing a DVD/Blu-ray disc. 

To create a DVD, the student will need:

•	 A DVD (or Blu-ray) recorder (most Blu-ray drives are backwards compatible 
with DVD) 

•	 A blank recordable (DVD+R/DVD-R) or rewriteable (DVD+RW/DVD-RW) disc

•	 A DVD player or Blu-ray disc  player. You may wish to note that commercially 
manufactured DVDs will play on virtually all DVD players, but recordable 
DVDs will fail on between 5-10 percent of DVD players. 

Observe that a single-layer DVD can store about 4. 7 GB of data, and a dual-layer 
disc can store about 8.4 GB, sufficient for 90 minutes or 180 minutes of high-
quality video. To include more content on the disc, you’ll have to increase the video 
compression which may reduce audiovisual quality. 

To create a Blu-ray disc, the student will need: 

•	 A Blu-ray recorder

•	 Blank Blu-ray media—either BD-R, which is write-once media, or BD-RE, which 
is rewriteable. 

•	 A Blu-ray player. Note that compatibility problems exist Blu-ray players and 
Blu-ray recordable discs, but they’re not as well documented as the DVD 
incompatibilities. 

A single-layer Blu-ray disc can store about 25 GB of data, enough for at least two 
hours of HD video at very high quality. While dual-layer, 50 GB Blu-ray discs exist, 
Adobe Premiere Elements records single-layer Blu-ray discs only. 
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When discussing compatibility issues, emphasize these have nothing to do with 
Adobe Premiere Elements. Rather, incompatibilities are often media related, or 
caused because many DVD/Blu-ray players were released before recordable tech­
nology existed and pre-dated compatibility testing. 

One tip is to use recordable discs, which are usually more compatible than rewrite­
able or erasable media. Another strategy is to avoid dual-layer media, which can be 
less compatible than single-layer discs. 

Also you’ll want to manage expectations on the disc features that Adobe Premiere 
Elements can generate. Specifically, while discs created with the application share 
many features with commercially-developed discs—such as chapter points, and 
audio and video menus—the navigational features available in Premiere Elements 
are very structured, and the program lacks the support for subtitles or multiple 
languages, as do virtually all other consumer-oriented DVD authoring programs.

Make the point that you can make both Blu-ray and regular DVDs from the 
same project; it just depends upon the disc output that you select and the type of 
recorder and recordable disc. Whichever you choose, Adobe Premiere Elements 
will format the video and record the disc appropriately. 

Understanding DVDs and Blu-ray discs
This is a good opportunity to make sure that students know the difference between 
DVD and Blu-ray discs and understand the myriad of variants (+R/-R/+RW/-RW/
BD-R/BD-RE). 

Manually adding Scene Markers
Scene Markers are critical to controlling the viewer’s access to content. Students 
may be familiar with the term “chapter points” which are used elsewhere. Note that 
Scene Markers allow Adobe Premiere Elements to generate Scene Selection menus 
just like commercial DVDs. 

Few students will want to create an auto-play disc or automatically generate Scene 
Markers, which are discussed in next two sections. Consider touching on these 
topics but, in general, working through these exercises probably wouldn’t be a good 
use of classroom time. 

Creating a disc with menus
This section reviews the types of menus available and how Adobe Premiere 
Elements always displays the relevant commands for each. This section could 
be skipped if time is short. 
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Modifying scene marker buttons
This is an important and straightforward exercise. Observe that button labels 
should only be one or two words in length, otherwise they typically won’t fit within 
the button shape (and remain legible on a standard TV screen.) 

Working with submenus
Consider covering the “Three types of menu markers” sidebar before diving into 
these materials. That way, the students will learn what the links do before they 
learn how to apply them. 

Customizing menus in Properties view
This and the related exercises in this lesson are critical territory because most 
students will want to customize their menu templates. Make the point that if the 
student wants full screen video in the menu background, they need to choose a 
menu template without a drop zone. 

Also note that while a producer can perform DVD menu customization, doesn’t 
mean that she should. In particular, moving thumbnails take a long time to render 
and look pretty funky, and since video and audio menus have a maximum duration 
of 30 seconds, after which they repeat, looping thumbnails can be irritating in use. 

Creating WebDVDs
Discuss that you can host WebDVDs either on your own site or on Photoshop.com. 
Then walk through the straightforward process of creating a WebDVD. 

Burning DVDs or Blu-ray Discs
Choose a teaching strategy that suits whether recorders will or will not be available 
in your classroom. 

Questions
1	 How should students address incompatibilities between writable and rewritable 

discs and some DVD and Blu-ray players? 

2	 How much video content can a DVD contain while retaining very good 
audiovisual quality? 

3	 What’s the maximum duration of video menus and what happens after then? 
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Answers
1	 They should inform their viewers that incompatibilities are an unfortunate fact 

of life. Since some of these problems are media related, once they find a media 
brand that works for them, they should also stick with it. Students should avoid 
rewriteable and dual-layer media. 

2	 Placing more than 90 minutes of content on a single-layer disc can require data 
compression levels that will degrade video quality. 

3	 The maximum duration is 30 seconds. After that, the video starts over and 
replays endlessly, sometimes to irritating effect.

Lesson 12: Sharing Movies
Lesson 12 explores how students can share videos with friends, family and associates, 
including uploading videos to YouTube, exporting a video file for viewing from a hard 
disk-based or mobile device, and how to record video to DV/HDV tape. 

Goals for this lesson
The objectives for this Lesson 12 are to familiarize students with their options for 
sharing movies produced in Adobe Premiere Elements, aside from the optical disk 
platforms  discussed in Lesson 11.

•	 Your students should be able to upload a video file to YouTube. 

•	 They should be capable of exporting a file for viewing on a hard drive-based device. 

•	 Your student should learn how to create a file for uploading to an iPod or other 
mobile device. 

•	 They should know how to record a video file to DV/HDV tape. 

Getting started
Adobe Premiere Elements supports multiple ways to share videos, and the most 
desirable method will differ from student to student (and project to project.) Some 
students prefer using YouTube, some want to email to friends or post to a web site, 
others want to upload videos to their iPods or archive to tape. None of these are 
conceptually difficult, but you’ll have to budget your time carefully to make sure 
that you explain them all. 

The common concern in all these methods is encoding time, which can be lengthy 
on older computers. You may get the best results (and save a lot of classroom time) 
if you take the students to the brink of each sharing method, but never click the 
Save button (or cancel the encoding process after you do). 
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Opening discussion 
Ask the students to open their Share panels and then identify and briefly discuss 
the output options one by one. Then, to get the students involved, ask them which 
option is most important to them, and perhaps ask students interested in a particu­
lar technique to lead a discussion on that output option.. 

Uploading to YouTube
Premiere Elements makes it extremely simple to upload files to YouTube, and there 
are presets for SD 4:3 and widescreen, and two HD upload options. 

Uploading to Photoshop.com
Photoshop.com offers a high quality viewing experience (no advertisements like 
YouTube) and high quality video, not to mention 2 GB of free backup. Now’s a 
good time to reinforce these benefits and show how easy it is to upload to the site. 

Sharing on your personal computer
First, review the Formats sidebar to familiarize students with the available formats. 
Discuss the strengths and weaknesses of each format as described in the sidebar, 
and ask the students which formats they plan to use. If Windows Media doesn’t 
predominate, consider changing the exercise to the most popular format. 

Be sure to explain that FLV is the most popular format on the web (for Flash 
players), but it requires a special desktop player for playback outside of a browser 
environment. Most users still don’t have such a player, which is why it makes little 
sense to email files in this format to friends. 

Ask if any students will be publishing their files to a web site other than YouTube. 
Dig into details like which site, and research that site’s encoding and uploading 
requirements, so all class members can learn which formats and encoding strate­
gies should be used. 

Explain that when students create files for video distribution websites such as 
YouTube, Google Video, Yahoo Video, blip. tv, Vimeo and so on, they should check 
the site for file uploading requirements. If the upload rules aren’t followed, the 
videos may look suboptimal or may not be accepted. 

Exporting to mobile phones and players
Ask which devices students will be using. If iPod doesn’t predominate (unlikely), 
work through the exercise using the most popular device. If you do produce for 
iPods, make students aware that producing videos in High Quality will produce 
video that’s not compatible with older iPods. 
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Preparing to export to tape
The Universal Counting Leader added to the video project is fun, but not essential. 
You can leave this step out if pressed for time. 

Make the point that students who need to create VHS copies can connect the ana­
log outputs of their DVD camcorder to a VHS recorder and record on that device 
while recording to the DV camera. 

Exporting a frame of video as a still image
This is an important exercise because still frames are useful in both titles and DVD 
menus. Suggest that exported frames are often the best starting point for a DVD menu. 

Questions
1	 When is Adobe Premiere Elements not the best choice for uploading files to 

YouTube? 

2	 When are FLV-format video files appropriate, and when should you avoid them? 

3	 How do you know what format to encode to when creating a file for a user-
generated content website? 

Answers
1	 When you’re attempting to access YouTube High Quality or High Definition modes. 

2	 FLV files are appropriate when creating a file to upload to a website for playback 
on a Flash-compatible browser. However, you should avoid using FLV file for 
desktop playback unless you know that the person you’re sending the file to has 
an FLV player. 

3	 Most sites list their specifications and requirements in a FAQ or similar document. 

Lesson 13: Working with Adobe 
Photoshop Elements
Lesson 13 details how to use Adobe Photoshop Elements and Adobe Premiere 
Elements in concert to seamlessly combine digital photography and video edit­
ing. To complete these exercises, students must have Adobe Photoshop Elements 
installed on their computers. 

Goals for this lesson
The objectives for Lesson 13 are to familiarize students with methods for combin­
ing the use of Adobe Premiere Elements and Photoshop Elements. 
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•	 Your students should know how to use the Send To command in Photoshop 
Elements to create a slide show in Adobe Premiere Elements, and how to paste 
images into Adobe Premiere Elements. 

•	 Students should be able to access albums created in Photoshop Elements in 
Adobe Premiere Elements. 

•	 Your students should create a Photoshop file optimized for video, and edit an 
Adobe Photoshop images in Adobe Premiere Elements. 

Getting started
Most copies of Adobe Premiere Elements currently in use were sold are bundled 
with Photoshop Elements. In addition, we intuitively know that most videographers 
also shoot still images, even if the reverse isn’t true. These facts suggest that most 
Adobe Premiere Elements users will be interested in learning how to improve their 
productions with Photoshop Elements. Of course, this doesn’t mean that teach­
ing these techniques fits your class curriculum. This is especially true if your class 
computers don’t have Photoshop Elements installed, a necessity for completing 
these exercises. 

However, the concepts in this lesson are relatively simple to grasp, and could be 
covered in a ten minute fly-by, if necessary. On the other hand, the exercises in this 
chapter could fruitfully consume a full 45-60 minute class period. You decide. 

The one scary prospect to consider is that a basic familiarity with Photoshop Elements 
is assumed. Though most of the functionality discussed in the lesson, like creating 
albums, is very similar to what the students learned in Lesson 4, if you’re starting from 
ground zero with novice users, you could lose them very quickly. Keep this thought 
in mind when deciding how to approach this subject in your class. 

Opening discussion 
Consider opening the discussion with a show of hands of those students who have 
Photoshop Elements installed on their home or office computers. Then ask how 
many students also shoot still images for standalone use or for integration to their 
video productions. 

Then discuss the high level benefits of using the two programs together. Most sig­
nificant is the ability to access Photoshop Elements albums in Premiere Elements, 
which makes it easy to integrate still images into video productions. You can also 
select images in Photoshop Elements and use the Send To command to create a 
slideshow in Adobe Premiere Elements, or paste images copied in the still image 
editor into the video editor. 

Finally, you can create a still image file in Photoshop Elements that’s optimized for 
video project use, and then import and edit that file in Adobe Premiere Elements. 
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This allows producers to integrate unique features from Photoshop Element— 
such as thought bubbles—into an Adobe Premiere Elements project. 

Using the Edit Videos command in Elements Organizer
Be prepared for a bright student to ask why it wouldn’t be simpler to open the 
album in Adobe Premiere Elements and create the slide show using those tools. 
The answer: That’s a good alternative as well. If you don’t get asked, make the point 
yourself, and continue into the sidebar. 

Loading an Album from Adobe Photoshop Elements 
If you’re in a hurry, just jump to this option, which is the easiest and most functional. 

Creating a new Adobe Photoshop file optimized for video
Introduce this discussion by identifying a number of purposes that optimized 
still images can serve in a video project, such as titles, menu backgrounds, and 
text overlays. Note that Adobe Premiere Elements’ title tool is very capable, but 
Photoshop Elements adds an additional level of feature sophistication. In essence, 
this lesson teaches students how to use Photoshop Elements as a high-powered 
titling utility for Adobe Premiere Elements. 

These exercises are conceptually simple but detailed, so go through them slowly 
and make sure that your students keep up. 

Question
1	 What’s the easiest and most effective way to use still images from a Photoshop 

Elements album in an Adobe Premiere Elements project? 

Answer
1	 Open the album in Adobe Premiere Elements and then use those images as desired. 




